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AU480 Software Overview 

 
Objectives 

 

This document identifies AU480 common software menu 
components.  It also contains a software chart and description of 
software screens. 
 
Software navigation and interaction is needed for successful 
operation of the instrument. 

 
Reference 

 

 
User’s Guide 
Software Chart (at the end of this document) 
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AU480 Home Menu 
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Common Screen Elements 
 

Main Button Bar* 
Button Description 

 
Home Select this button to display the Home screen 

 

Menu 
List Select this button to display the Menu List screen 

 

User 
Menu 

Select this button to display the User Menu List screen 
(configured by the user) 

 
Mode 
Display 

Indicates the current mode of the system.  Displays the time 
remaining for certain operations 

 

Measure 
Start Select this button to start/restart analysis 

 
Pause Select this button to pause sampling.  Select Start to resume 

sampling. 

 

Feeder 
Stop Select this button to stop the rack feeder 

 

Stop/ 
Standby 

Select this button to stop analysis.  All data in process will be 
lost.  When the system is stopped, select this button again to 
return the system to standby mode 

 

Online 
Help 

Select this button to access online operational help (available 
when the system is in Standby/Stopped) 

 
Log Out Select this button to log out the user 

 

Shut 
Down / 
End 
Process 

Select this button to shut down system operations and switch 
off the auxiliary power supply 

 
Current 
Date/Time Displays the current date and time 

*The Main Button Bar is viewable from all software screens. 
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 Home Menus 

Menu Description 

 
Sample Status:  A real-time display that is used to monitor the 
status of samples during analysis. 

 Analyzer Status:  Used to display the analyzer status 

 
Simple STAT Analysis:  Provides access to an alternate 
software option to use the STAT table 

 
 

 Messages 
 

A message display area on the Home Menu alerts the operator of conditions that 
currently exist on the system. 

 
Button Description 

 
Error 

Symbol 
Changes color or symbol according to the 
last message displayed. 

 

Message 
Window 

• Real Time Messages that provide 
information to the operator 

 
• Displays in green, yellow, orange or red 

to indicate message severity   
 

− Red messages require operator 
attention before system can process 
samples 

 
• The user may select a message to 

highlight the affected component on 
instrument diagram 
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Jump Buttons 

All of the software screens required for Daily Start Up and Daily Maintenance can 
be accessed using the “jump” buttons. 

Button Description 

 

Create a data index, which includes setting the index date 
and time, start sample number, group of tests and 
operator name. 

 

Check detailed reagent/calibration information, including 
the number of tests available in each on board reagent 
bottle. 

 

Access the maintenance menu and perform maintenance 
operations. 

 

Use to requisition calibrations, quality control or routine 
patient samples. 

 

View the Status of the STAT table and start STAT sample 
analysis. 

 

Display analysis results, perform data correction, print data 
lists and batch transfer data. 

 
 

 

 Alarm Displays 
 

An alarm message display area displays at the bottom of most menus to alert the 
operator of any alarms that occur. 

 
Button Description 

Alarm Message Alarm message displays to the left of the 
Alarm Clear button. 

 
Alarm Clear Select once to silence an alarm, and a 

second time to clear the alarm displayed. 

 
Alarm List Select to display the alarm list. 
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AU480 Menu List 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
• The left column provides the user access to the software tree 
• The right column displays sub-menus of the menu selected in the left column 
 

Menu Buttons 
 
Menu Buttons are available from the Menu List screen to access the software tree.  Select a 
Menu button to display sub-menus specific to the menu topic. 

 
Routine 

Basic operation menus for performing tests.  Includes setting start 
conditions, managing reagents, assigning racks, viewing status of 
samples, programming samples/calibrations/QC, repeating results, 
managing samples, and monitoring data. 

 
Calibration Display and manage calibration results and histories 

Quality 
Control Display and edit quality control (QC) results and histories 

 
Parameters Set analysis parameters.  Includes common and specific test 

parameters, repeat parameters, calibration and QC parameters 

 
Maintenance Perform maintenance, view generated maintenance alarms, perform 

diagnostics 

 
System 

Customize the system setup.  Includes online communication setup, 
format reports, create comments, setup system conditions, create 
user menu, and external data management 
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Buttons/Tabs 
 
• Buttons are available within a menu to select a sub-menu 
• Tabs are available within a sub-menu to select a topic 
• Function buttons are available at the bottom of some screens to perform 

functions specific to that screen 
 

 
 

Software Chart 
• Utilize the chart to navigate all the software areas of the AU system.  The 

Software Chart is located on the following pages and can also be found in the 
AU480 Quick Response Guide. 

Buttons 

Tabs 

Function Buttons 
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AU480  Software  Chart

 Start Condition

	Reagent	►
 Reagent Management
 Reagent Inventory
 Reagent Consumption

	Rack	Requisition	►
 Sample
 Calibration
 QC

	STAT	Requisition	►
 STAT Status
 Sample
 Calibration
 QC 

	Repeat	Run	 ►
Repeat Order
Repeat Data Verification

	Sample	Manager	►
Sample
RB/CAL/QC

	Data	Monitor	►
Reaction Monitor
Data Statistics
Correlation Chart

 Calibration Monitor 
 
	Calibration	Verification	►

Calibration Verification
Material Parameter

 QC	Monitor	►
Daily Chart
Day to Day Chart
Twin Plot Chart

 QC Data Review

 Main Menu 
Routine                     Calibration                        QC          
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	Common	Test		Parameters	►
Test Name
Profile
Group of Tests

	Specific	Test	Parameters	►
 General
 LIH
 ISE
 HbA1c
 Calculated Tests
 Range

	Repeat	Parameters	►
Repeat Common
Repeat Specific

	Calibration	Parameters	►
 Calibrators
 Calibration Specific
 STAT Table Calibration

	QC	Parameters	►
Controls
QC Specific
STAT Table QC

 Misc
 Checked Tests
 Contamination Parameters
 Data Check Parameters

 Online

	Format	►
Requisition Format
List Format

 Comment Masters

	System	Condition	►
Analysis Mode
Set Date and Time
Auto Power On
Password
Login Condition

 User Menu

 External Data 
	Management	►

External Data  
Management
File Management
Offline Format

User	Maintenance	►
Analyzer Maintenance
ISE Maintenance
OSV 
Load Reagent 
Parameters

 
Alarm Log

Maker	Maintenance	►
Program Version
Analyzer Diag
ISE Diag

 Parameters                          Maintenance                   System 
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12.1 Home Menu
The “Home” window appears when the system starts up. The menus displayed on the “Home” 
window are referred to as “Home menus”. Users can advance to various menus from this window. 
The list of menus included in the “Home menu” is indicated below. Also, individual menu functions are 
summarized. 

Home Menus 

Menu Submenu Option
Home Menu Sample Status

A real-time display used to monitor 
the status of samples during analysis 
as well as their print status.
Analyzer Status
Used to display the analyzer status.
Simple STAT mode
Allows an untrained operator to run a 
sample using the STAT table.
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12.2	Permanently	Displayed	Button	Configuration	
and	Function	

The multiple function buttons located at the upper and lower outside of the Home menus are always 
displayed whatever menu is selected. 

Group	of	Function	Selection	Buttons	
Button Button name Function

Home Displays the Home window.

Menu List Displays the menu list.

User Menu Displays the user menu list.

Group of System Control Buttons 
Button Button name Function

Start Starts or restarts analysis.

Pause Temporarily stops sampling.

Feeder Stop Temporary stops the rack feeder 
during analysis.

Stop/Standby Transfers the system to the Stop 
mode and transfers from Stop back to 
Standby.

Group of Alarm Related Buttons 
Button Button name Function

Alarm List Displays the alarm list.

Alarm Clear Button for silencing an alarm and 
clearing the alarm display field.

Group of Other Buttons 
Button Button name Function

Help Displays the Help window.

Logout Facilitates operator login and logout.

End Shuts down the system.
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12.3 Menu Buttons Overview 
To perform parameter setup necessary for analysis, requisition concerning analysis, and check for 
analysis results after operation, select a menu from various menu buttons at the left side of the “Menu 
List” window.

The display contents of submenus displayed to the right vary depending on the selected menu. 
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12.4 Routine Menu
The “Routine menu” is a group of basic operation menus for performing test. Unless the basic setup is 
performed beforehand with the [Parameters] menu, some submenus cannot be used. 

Menu Submenu Option
Routine Start Condition

Used to set the index date and 
time, start sample number, 
etc., before starting analysis. 

Reagent Reagent	Management 
Used to check the quantity of reagent and the 
number of tests available in a bottle. 

Reagent	Inventory	
Sets up the reference value for each day of the 
week to perform a daily check. 

Reagent	Consumption	
Displays the number of shots consumed each 
day for each reagent. 

Rack	Requisition Sample 
Used to set the sample numbers and analysis 
items required for rack analysis. 

Calibration 
Used to set the requisitions for calibration for 
rack analysis. 

QC
 Used to set the requisitions for quality control 
analysis for rack analysis.

STAT	Requisition STAT Status 
Use to view the status of the STAT table and 
start STAT sample analysis. 

Sample 
Performs requisition of patient samples to be 
analyzed on the STAT table.

Calibration 
Performs requisition of calibrators to be 
analyzed on the STAT table. 

QC 
Performs requisition of QC samples to be 
analyzed on the STAT table. 

Repeat Run Repeat Order 
Used to requisition repeat samples. 

Repeat	Data	Verification	
Used to view repeat results and perform 
overwriting of the data. 
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Menu Submenu Option
Routine Sample	Manger Sample

Used to display analysis results, perform data 
correction, print data list and batch transfer data 
online. 

RB/CAL/QC
Used to print and batch transfer RB/ CAL/QC 
results online. 

Data Monitor Reaction	Monitor
Displays information about reaction processes of 
analysis results.

Data	Statistics
Displays key statistics of patient sample results 
and the results of a test within one index as bar 
charts. 

Correlation Chart
Displays a correlation chart.

12.5 Calibration Menu
The “Calibration menu” is a group of menus for displaying and managing calibration results and 
histories. 

Menu Submenu Option
Calibration Calibration Monitor

Displays calibration results as 
a graph or a data list. 

Calibration	Verification Calibration	Verification
Verifies the calibration performance.

Material Parameter
Set Parameters for calibration verification.
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12.6 QC Menu
The “QC menu” is a group of menus for displaying and editing quality control (QC) results and 
histories. 

Menu Submenu Option
QC QC Monitor Daily Chart

Display the QC data variation within the same 
or between index dates as a daily chart.

Day to Day Chart
Display the QC data variation within the same 
or between index dates as a day to day chart.

Twin Plot Chart
Display the QC data variation of two QC 
samples as a twin plot chart.

QC Data Review
Used to edit QC result.
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12.7 Parameter Menu 
 The “Parameters menu” is a group of menus for setting various parameters such as the analysis 
method. Be sure to set those parameters before using this system for the first time. To set the system 
own conditions, use the “System menu”. 

Menu Submenu Options
Parameters Common Test 

Parameters
Test Name
Used for basic parameters such as test name 
and reagent ID. 

Profile
Used to select specified test items for one 
profile. Multiple profile setting for samples, RB/
Calibration and QC is possible. 

Group of Tests
Used to set the round name and test items for 
each round. 

Specific	Test	
Parameters

General
Used to set detailed parameters for general test 
items. 

LIH
Used to set detailed parameters for the Lipemia/
Icterus/Hemolysis test. 

ISE
Used to set detailed parameters for the ISE test. 

Calculated	Tests
Used to set detailed parameters for calculated 
tests.   

Range
Used to set parameters for the reference range 
of each test. 

Repeat Parameters Repeat Common
Used to set the common parameters for a repeat 
run analysis. 

Repeat	Specific
Used to set the repeat and reflex decision ranges 
and the repeat dilution rate of repeat run analysis 
for individual test items. 

Calibration Parameters Calibrators
Used to set common calibrator parameters such 
as name, ID and Lot number. 

Calibration	Specific
Used to set specific calibration parameters for 
individual test items. 

STAT Table Calibration
Used to set parameters for calibration analysis 
using the STAT Table. 
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Menu Submenu Options
Parameters QC Parameters Controls

Used to set the common parameters for a quality 
control analysis. 

QC	Specific
Used to set the average value and standard 
deviation of the control sample for quality control 
of individual items. 

STAT Table QC
Used to set parameters for QC analysis using 
the STAT Table. 

Misc. Checked	Tests
Used to set parameters for logic checked tests. 

Contamination Parameters
Used to set parameters for contamination of tests 

Data	Check	Parameters
Used to set parameters for data check such as 
diagnosis of prozone. For detailed information, 
contact Beckman Coulter Sales or Technical 
Services. 

12.8	Maintenance	Menu	
The “Maintenance menu” is a group of menus that are used for daily maintenance of the system. It 
allows the user to plan a maintenance schedule and check for a generated alarm. 

Menu Submenu Options
Maintenance User	Maintenance ANL	Maintenance

Used to display the maintenance schedule and 
provide instruction on maintenance procedures.

ISE	Maintenance
Used to display the maintenance schedule 
of the ISE unit and provide instruction on ISE 
maintenance procedures. 

OSV
Displays the connection status of the Beckman 
Coulter Support Vision (OSV) and transmits the 
AU480’s various files.

Alarm	Log
Chronologically lists the alarm 
that have accrued. 
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12.9 System Menu 
The “System menu” is a group of menus used for setting the print format, use/nonuse of barcode, 
optional conditions, etc. 

Menu Submenu Options
System Online

Used to set the parameters for 
online communication between 
a host computer and the 
system.

Format Requisition	Format
Used to enter the sample requisition 
parameters.

List	Format
Used to set the common format parameters for 
printing the pending list, work list, repeat list and 
the data list.

Comment Masters
Used to customize the 
comments appended to the 
analysis results.

System Condition Analysis mode
Used to set the analysis mode, barcode 
definition, auto/standard repeat and so on.

Set Date and Time
Used to set the system date and time.

Auto Power On
Used to set the auto power on time for each day 
of the week.

Password
Used to set and change passwords

Login	Condition
Used to set login information.

User Menu
Used to set a menu as a user 
menu.

External	Data	
Management

External	Data	Management	
Saves the analysis data on an external storage 
device or media.

File	Management
Used to save and up load parameter files on an 
external storage device or media.

Offline	Format
Used to set the output format of results and 
save data in a delimited format for use in 
external applications (spreadsheets, etc).

 




